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Mission Overview
In this tutorial, we will model a Mission to Mars. Starting from the Earth, we will: 

1. Use the Target Vector Outgoing Asymptote parameters to specify our outgoing state.  

2. Use a Trajectory Correction Maneuver to target Mars approach parameters. 

3. Coast to Mars Periapsis 

4. Perform an impulsive Mars Orbit Insertion (MOI) maneuver. 

5. Circularize our orbit at 90 degrees. 

 

At the end of this exercise we will have: 

1. Used a TCM maneuver in a Mission Control Sequence. 

2. Used Multiple Profiles to achieve our desired Martian parameters 

3. Used Constraints to help us target. 

4. Created Mars-Centered views in STK. 

5. Created a trajectory that leaves the Earth enters heliocentric space, and then orbits Mars. 
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Setting Up the Scenario 

Setting up to Scenario and Animation Times 

1. Open a new scenario in STK. By default, you should get a 3D Window and a 2D Map. We will 
configure these windows later for our Mars mission.  

2. Name the scenario ‘Mars_Mission’. 

3. Specify the timeframe of the mission. This is important since the objects that don’t fall within 
the interval of the scenario will not be displayed. The orbit epoch of this particular mission is 
July 15th, 2003. This is a good reference time for our scenario; therefore, we will use it as our 
start time. 

a. Right click on the ‘Mars_Mission’ scenario and select Basic Properties. On the 
Time Period page, enter the follow parameters: 

Time Period 

Element Value 

Start Time 15 Jul 2003 00:00:00.00 

Stop Time 16 Jul 2003 00:00:00.00 

Epoch 15 Jul 2003 00:00:00.00 

 

b. Select the Animation page and introduce the following dates: 

 

Animation 

Element Value 

Start Time 15 Jul 2003 00:00:00.00 

Stop Time 16 Jul 2003 00:00:00.00 

Time Step 60 sec 
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Note 
You can access the Basic Properties of any object in STK by double-clicking on its object icon.

 

Setting up the 2D and 3D Windows 

We are now ready to configure the 2D and 3D windows for our mission to Mars.  We will use the 
following settings to visualize the orbit from a Mars equatorial position. 

2-D WINDOW SETTINGS 

4. Select the 2-D window, and click on the Central Body button    from the 2-D Graphics 
toolbar. 

5. Change the Central Body to Mars. 

6. Select the 2-D window, and click on the Properties button  from the default toolbar.  

7. From the Details Page, Turn off Image and deselect all the high resolution detail Items. 

8. From the Projection page: 

a. Change the Type to Orthographic. 

b. Change the Display Coordinate System Frame to ‘CBI’ (Central Body Intertial). 

c. Change the Display Height to 40000 km. 

d. Change the Center to Lat = 0 deg & Lon = 115 degrees. 

e. Turn on Show Axes and click on the Format… button.  

i. Turn on All Axes. 

ii. Change the color to Green for Plus and Red for Minus.  

iii. Change the scale to 30 for both Axes.  

iv. Change the coordinate frame to CBI  

f. Click on Apply when done and on the reset button to refresh the 2D Map. 
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9. Dock the 2-D window to the top of your application (Select the window, and right click on the 
upper blue bar of the window for these options).  We’d like the windows to be visible during 
targeting so it’s best not to leave them Integrated, or Floating.   

3D WINDOW SETTINGS 
10. Select the 3-D window, and click on the Properties button. 

a. From the  Globe page, change the Central Body to Mars. 

b. From the Details page, select Show Equator and Show Prime Meridian. 

c. On the Celestial page, turn the ‘Ambient Level’ to zero, in the Global Lighting area. 

d. On the Advanced Page, change the Visible Distance to 1e+009 km 

e. On the Grids page, turn the CBI grid on, change the color to dark gray, and show 
radial lines. 

f. On the Vector page, activate the Sun vector and the Mars J2000 Axes. 

11. From the View menu, Create a new 3D Graphics Window. 

a. From the  Globe page, change the Central Body to the Sun. 

b. On the Advanced Page, change the Visible Distance to 1e+012 km 

12. Dock your 3Ds window to the top as well, and try to position things to that you can see them. 
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Populating the Scenario 

In this particular scenario, we only need two types of STK objects: Planets and Satellites.  

CREATING PLANETS 
13. With the scenario selected, from the Insert menu, select New and then Planet.  

a. From the Basic Properties of the new planet, on the Definition page, select ‘Mars’ 
as the central body. 

b. From the 2-D Graphics/Attributes page, deselect Inherit from Scenario, Show 
Subsatellite Point, and Show Subsatellite Label and select the Show Orbit box, 
and select the color to be red. 

14. Copy and Paste Mars into the scenario again, and then redefine it to be ‘Earth’. 

a. Configure the planet the same as Mars, except select the color to be blue and change 
the name to ‘Earth’. 

CREATING THE SPACECRAFT 
15. With the scenario selected, from the Insert menu, select New and then Satellite.  Dismiss the 

orbit wizard. 

16. Name the satellite ‘Mars_Probe’.  

17. Select the Basic Properties of the satellite. 

18. From the Orbit page, change the propagator to ASTROGATOR.  

19. Remove all the segments in the Mission Control Sequence (MCS) using the Delete Segment 

button . 

20. On the 2-D graphics page/Pass page turn the Orbit Track/Lead Type to All and set the 
Ground Track/Lead Type to None. 

21. On the 3-D graphics page/Pass page turn the Orbit Track/Lead Type to All. 

22. From the 3-D graphics/Model page: 

a. Change the Marker to ‘Point’  

b. Change the scale to 7.  
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c. For the Detail Thresholds, slide the Marker label and the Marker bars to the maximum.  

 

Building the Mission Control Sequence (MCS) 

Get out of Orbit. 

1. Create a new Target segment, and label it ‘Target_Mars’. 

2. Inside the target segment, add an initial state segment. 

a. Set the Element type to Target Vector Outgoing Asymptote. 

b. Set the  Orbital Elements as follows: 

i. Orbit epoch = 6 Jun 2003 18:18:28.00 UTCG 

ii. Radius of Periapsis = 6778 km. 

iii. C3 Energy = 8.7949 km^2/Sec^2. 

iv. RA of Outgoing Asymptote = 348.941 deg. 

v. Declination of Outgoing Aysmptote = -6.4025 deg. 

vi. Velocity Azimuth at Periapsis = 0 deg. 

vii. True Anomaly = 0 deg. 

c. Set C3, RA and Declination as Controls.  

3. After the initial state segment, add a propagate segment named ‘Prop to SOI’.  Change the 
color as you see fit. 

a. Leave the stopping condition as ‘Duration’. 

b. Change the Trip value to 1 Day. 

c. Set the Propagator to ‘Cislunar’. 

4. Add a propagate segment named ‘Prop to TCM’.  Change the color as you see fit. 

a. Change the stopping condition to ‘Altitude’, and make the altitude relative to Mars. 
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b. Change the Trip value to 40,000,000 km.  This will stop the propagation when the 
satellite gets within 40 million km of Mars. 

c. Set the Propagator to ‘Heliocentric’. 

5. After the Propagation segment, add an impulsive burn segment named ‘TCM’. 

a. Change the Attitude Control to Thrust Vector. 

b. Change the thrust axes to ‘Sun VNC’. 

c. Set X, Y and Z as Controls.  

6. After the TCM segment, add a propagate segment named ‘Prop to Mars’. 

a. Change the propagator to Heliocentric. 

b. Give the segment a stopping condition of altitude (WRT Mars) of 50 km.  This will 
prevent the trajectory from impacting Mars. 

c. Give the segment a 2nd stopping condition of periapsis: 

i. Give the periapsis a condition a constraint that it’s altitude (above Mars) be less 
than 200,000 km. (Bring up the Altitude Calculation object and make sure it’s 
central body is Mars) 

 

We constrain our periapsis condition to prevent the stopping condition from being met when 
we haven’t actually encountered a periapsis.  Periapsis is measured within STK by following 
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the altitude along the orbit track.  If the altitude reaches a minimum and starts rising again, 
STK thinks it has achieved periapsis.  Since it is possible that we could encounter this 
condition before actually getting near Mars, we can constrain this condition and only accept 
periapses that are within 200,000 km of Mars.   

Hit Mars 

7. Add 3 results to the ‘Prop to Mars’ segment: 

a. From the ‘MultiBody’ Calc Object folder, Delta Right Asc. 

b. From the ‘MultiBody’ Calc Object folder, Delta Declination 

These constraints are the targeted differences in the right ascension and declination angles 
between the spacecraft at the end of the segment and the selected central body (Mars) with 
respect to its parent body (Sun).  Note that both of these default to a selected central body 
of the Moon. 

c. Epoch. 

8. Select the ‘Target Mars’ targeter, and name the default Targeting Profile ‘RA Dec’. 

9. Set the Profile Mode to Iterate, and set the Action for the targeter to ‘Run Active 
Profiles Once’. 

10. Select the Properties button for the profile, and activate the Controls and Constraints 

a. Activate the Controls: 

i. C3.  Perturbation of 0.0001 km^2/sec^2, Max Step Size of 0.05 
km^2/sec^2. 

ii. RA of Outgoing Asymptote.  Perturbation of 0.1 deg, Max Step Size of 1 
deg. 

iii. Dec of Outgoing Asymptote.  Perturbation of 0.1 deg, Max Step Size of 
1 deg. 

b. Activate the Constraints 

i. Delta Right Asc.  Leave as defaults. 

ii. Delta Declination.  Leave as defaults. 

iii. Epoch.  25 Dec 2003 20:36:26, tolerance of 1 hr. 
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11. Run the sequence.  Check the 3-D window to see how close the trajectory appears to be to 
Mars. 

12. Set the Targeter Action to Run Active Profiles. 

13. Turn on Draw Trajectory as it is Calculated under the MCS Options button on the 
Astrogator Toolbar. 

14. Run the targeter.   

15. Right Click on the ‘Prop to Mars’ segment, and change the coordinate system to ‘Mars 
Centered Inertial’. 

 

16. Bring up the Summary Report on the ‘Prop to Mars’ segment, and inspect both the ‘Stopped 
On’ condition (which identifies which stopping condition ended the segment) and the altitude 
(above Mars) at the time.  Given that we targeted Delta RA and Delta Dec to be zero, we should 
have produced an impact trajectory.  Did we?  

17. Note the end of segment time for Prop_to_Mars segment.  Paste this time (and then subtract 
one second) into the Animation toolbar and look at the trajectory in the 3-D windows. 

18. Run the animation to watch the trajectory. 

 

Target the B-Plane 

Now we have an impact trajectory, which is close, but we want to get to orbit.  The best way to 
do that is target the B-plane. The B-plane is a planar coordinate system that allows targeting 
during a gravity assist or for planetary orbit insertion. It can be thought of as a target attached 
to the assisting body.  If you have a trajectory that is close to the encounter planet, the B-plane 
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gives you targets that behave very linearly, which is important with the differential corrector 
targeting scheme in Astrogator.  However, had we targeted the B-plane before we had proper 
initial conditions (i.e. we were pointing in some random direction) this would not have worked 
since we may never have crossed the plane.  We first had to target to get close to Mars, and 
only then were we close enough to Mars with our trajectory to use B-plane targeting. 

 

 

The b-plane is defined to be the plane that contains the focus of an idealized two-body 
trajectory (assumed to be a hyperbola) that is perpendicular to the incoming asymptote of that 

hyperbola. The incoming and outgoing asymptotes,  and , and the focus are contained in 
the trajectory plane, which is perpendicular to the b-plane. The intersection of the b-plane and 
the trajectory plane defines a line in space. The b-vector is defined to lie along this line, 
starting on the focus and ending at the spot where the incoming asymptote pierces the b-

plane. The vectors and lie in the b-plane and are used as axes. 

Now that we have found the right direction of our transfer trajectory, we can adjust our first 
guesses of Outgoing Asymptote RA, Dec and C3 to target in on the desired final orbit. To do so, 
we will use the B-Plane parameters BdotT and BDotR. In this example, we are interesting in 
capturing around Mars in a 90 degree inclination orbit. Thus we will target a BdotT = 0 km 
and a BdotR = -10000 km that will bring our orbit along the North (BdotT is negative to the 
North).  Ultimately we will target an orbit of 90 degrees with a periapsis of 1000 km altitude.  
However, altitude and the b-plane parameters do not directly match, so we will guess a value 
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that gets us well off the surface of the planet above the north pole of Mars knowing that the 
Martian radius is 3386 km.  For our purposes, we will guess 10000 km. 

 

Let’s set up another targeting profile to achieve these goals. 

 

19. Add two new results to the ‘Prop to Mars’ panel. 

a. From the ‘MultiBody’ Calc Object folder, BdotT.  Reconfigure this result to be Mars 
centered. 

b. From the ‘MultiBody’ Calc Object folder, BdotR.  Reconfigure this result to be Mars 
centered. 

20. In the targeter panel, create another profile named ‘Bplane’. 

Recall that  in our first profile, we targeted using our Outgoing Asymptote conditions.  While 
we can do that in a real mission, there is a limit to the accuracy we can achieve in our launch 
state.   In a real mission, any errors in our launch conditions would be taken out using a 
Midcourse Correction.  In order to simulate this: 

a. Apply corrections from the first profile RA Dec, and make the profile inactive. 

b. Truncate the Outgoing Asymptote Ra and Dec down to the first digit after the decimal 
point to simulate the maximum precision available in a launch vehicle.  Leave the C3 
value the way it is. 

21. Select the Properties button for the new Bplane profile, and activate the Controls and 
Constraints 

a. Activate these Controls from the TCM segment: 

i. Cartesian.X.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 

ii. Cartesian.Y.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 

iii. Cartesian.Z.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 

b. Activate the Constraints 
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i. BdotT.  Value of –10000.  Tolerance of 1 km. 

ii. BdotR. Value of 0.0.  Tolerance of 1 km. 

iii. Epoch.  25 Dec 2003 20:36:26, tolerance of 1 hr. 

22. Set the Mode for the ‘Bplane’ profile to ‘Iterate’. 

23. Set the Targeter Action to Run Active Profiles Once. 

24. Run the targeter. 

25. Check the results window and see that our initial B-Plane parameters are reasonable. 

26. Set the Targeter Action to Run Active Profiles. 

27. Run the targeter again. 

28. Bring up the Summary Report on the ‘Prop to Mars’ segment, and inspect both the ‘Stopped 
On’ condition (which identifies which stopping condition ended the segment) and the altitude 
(above Mars) at the time.  Given that we targeted the b-plane at 10000 km, we should have 
some reasonable altitude above Mars, and we should be stopped on periapsis. 

 

Target Final Approach Conditions 

Now that we have refined our trajectory, we would like to achieve the exact Martian altitude and 
inclination we desire for our orbit.  We are interested in capturing around Mars in a circular, 90 
degree inclination orbit with an altitude of 1000 km.  

 

29. Add two new conditions to the ‘Prop to Mars’ segment. 

a. Inclination (set this to the ‘Mars Centered Inertial’ coordinate frame). 

b. R-Mag (set this to the ‘Mars Centered Inertial’ coordinate frame). 

30. Create another profile, called ‘Rp Inc’ 

a. Activate these Controls from the TCM segment: 

i. Cartesian.X.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 
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ii. Cartesian.Y.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 

iii. Cartesian.Z.  Perturbation of 0.0001 km/sec, Max Step Size of  0.001 
km/sec. 

b. Activate the Constraints 

i. Inclination.  Value of 90.  Default tolerance. 

ii. R-Mag. Value of 4386 km.  Default Tolerance. 

iii. Epoch.  25 Dec 2003 20:36:26, tolerance of 1 hr. 

31. Set the Mode for the ‘Rp Inc’ profile to ‘Iterate’. 

32. Run the targeter. 

33. Bring up the Summary Report on the ‘Prop to Mars’ segment, and inspect the ‘Stopped On’ 
condition (which identifies which stopping condition ended the segment) the altitude (above 
Mars) and the inclination (WRT Mars).  We should now have the parameters we desired. 

34. Select the ‘Target Mars’ targeter, and select ‘Clear all corrections’.  This should clear out 
everything we’ve targeted so far. 

35. Run the targeter again, and watch how the profiles converge sequentially, each time setting up 
the results slightly closer for the next profile. 

 

Get Into Orbit 

Now that we’ve gotten ourselves where we want at Mars, it’s time to get into orbit. 

36. Apply the corrections in the ‘Target Mars’ targeter, and change the Action for the targeter to 
Run Nominal Sequence.  Run the sequence again to make sure you did this in the right order. 

37. Create a new targeter after ‘Target Mars’ called ‘Get into Orbit’. 

38. Add an Impulsive Burn to the segment and name it ‘MOI’. 

39. Change the Attitude Control to Thrust Vector, and the Thrust Axes to Mars VNC. 

40. Activate the X(Velocity) vector as a control. 

41. Add two results to the MOI segment 

4/27/2004 

               
NOTES 

 



STK/Astrogator Mars Mission Tutorial – Page 15 

a. Eccentricity (WRT Mars) from the Keplerian Elements Folder. 

b. C3 Energy (WRT Mars) from the Target Vector Folder. 

42. Create a new propagator, called ‘Mars 4x4’ in the Astrogator Browser, and configure it as 
follows (use the default integrator): 

 

 

43. Add a propagation segment after the targeter called ‘Prop twice around’ 

a. Set the Propagator to Mars 4x4 

b. Set the stopping condition to Periapsis (WRT Mars) 

c. Set the Repeat Count to 2. 

 

C3 is the energy of the orbit, computed as –µ/a, where µ is the gravity constant of the central body 
and a is the Semi-major axis.   A negative C3 indicates that a spacecraft is captured and in orbit, 
while a positive C3 indicates a hyperbolic trajectory. 

 

Note 
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We’d like to target an eccentricity of 0.0 to get a circular orbit, but eccentricity switches sign when 
a spacecraft goes from being hyperbolic to being in orbit, so first we’ll target our MOI to get our C3 
negative, and then we’ll set the eccentricity to 0. 

44. Create two profiles in the targeter: 

a. Target C3 

i. Use X(Velocity) of MOI to hit C3 of –0.1 using default settings. 

b. Target Ecc 

i. Use X(Velocity) of MOI to hit Eccentricity of 0.01 within a tolerance of 0.01 

45. Set the modes of both Profiles to ‘Iterate’. 

46. Set the Action of the Targeter to ‘Run Active Profiles’. 

47. Run the targeter. 

48. Change the properties of the ‘Prop Twice Around’ propagator to use Mars Centered Inertial 
coordinates. 

49. Get the summary report from this segment and inspect the orbital elements. 

 

The initial state we used came from a ‘Porkchop’ plot of Earth-Mars opportunities for 2003: 

 

4/27/2004 

               
NOTES 

 



STK/Astrogator Mars Mission Tutorial – Page 17 

Try out some alternate trajectories.  Remember that your targeting profiles will need the new 
arrival date in addition to the initial state modifications. 

 

Mission Mariner 9 Viking 1 Viking 2
Launch date 30 May 1971 22:36:00 20 Aug 1975 21:22:00 9 Sep 1975 18:39:00

Arrival 14 Nov 1971 00:00:00 19 Jun 1976 00:00:00 7 Aug 1976 00:00:00
C3 9.374  km^2/sec^2 21.4905  km^2/sec^2 15.2799  km^2/sec^2
RA -35.8077  deg 85.6871  deg 79.2051  deg
Dec -28.3369  deg -11.4433  deg -3.4004  deg

Mission Mars Global Surveyor Mars Odyssey Mars Express
Launch date 7 Nov 1996 17:00:00 7 Apr 2001 15:02:00 2 Jun 2003 17:45:00

Arrival 12 Sep 1997 00:00:00 23 Oct 2001 02:26:00 20 Dec 2003 00:00:00
C3 9.8677  km^2/sec^2 10.8186  km^2/sec^2 8.8435  km^2/sec^2
RA 173.2313  deg -124.803  deg -8.705  deg
Dec 22.4338  deg -50.5085  deg -8.142  deg  
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